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Chapter 1. Legal
jGnash 2.33.x Manual

Copyright © 2001-{docyear} Craig Cavanaugh

jGnash comes with ABSOLUTELY NO WARRANTY.

This program is free software: you can redistribute it and/or modify it under the terms of the GNU
General Public License as published by the Free Software Foundation, either version 3 of the License,
or (at your option) any later version.

This program is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY; without
even the implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the
GNU General Public License for more details.

You should have received a copy of the GNU General Public License along with this program. If not, see
http://www.gnu.org/licenses/

Permission is granted to copy, distribute and/or modify this document under the terms of the GNU Free
Documentation License, Version 1.3 or any later version published by the Free Software Foundation;
with no Invariant Sections, no Front-Cover Texts and no Back-Cover Texts.

A copy of the license is included in the section entitled ''GNU Free Documentation License''.

Linux® is the registered trademark of Linus Torvalds in the U.S. and other countries. Windows is a
registered trademark of Microsoft Corporation in the United States and other countries. Java™ and
OpenJDK™ are registered trademarks of Oracle and/or its affiliates.
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Chapter 2. Introduction

jGnash is an open source application for personal finances. jGnash enables you to record detailed
account and transaction information using proven double entry accounting principles.

You do not have to be an accountant to understand or use jGnash, but jGnash provides options to make
new and experienced users feel comfortable using it.

jGnash’s mission is personal fiance and it is not tailored for use as a business accounting application.
jGnash is being used by small businesses and clubs, but if you require business specific features, you
may be better served looking for a different solution.

2.1. Features
A brief list of features is below:

• Double Entry Accounting with reconciliation tools.

• Budgeting with multiple scenario options and export to spreadsheet capability.

• Investment Accounts and automatic import of Stocks, Bond, and Funds price history.

• Nestable accounts with automatic rollup of totals and intelligent handling of mixed currencies.

• OFX, QFX, mt940, and QIF import with the ability to pre-process using JavaScript.

• Reminders and automatic transaction entry and notifications.

• Intelligent handling of multiple currencies and exchange rates with automatic online exchange
rate updates.

• Printable reports with PDF and spreadsheet export capability.

• XML and relational database file formats

• Operates on most all modern PC operating system (Java™ 8 is required).

2.2. Installation
jGnash is not currently distributed with an automatic installation tool. You will be required to perform
a couple of manual operations that are easily performed for those with a basic understanding of how
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to use a zip file. Also, you must have Java™ 8 or newer installed on your computer.

Java can be downloaded and installed from http://java.com. Java installation is a simple matter of
downloading the correct version for your operating system and using the automated installer.

If you are using a Linux® based operating system, OpenJDK™ or IcedTea may have been pre-
installed. jGnash will run on the latest version of OpenJDK or IcedTea, but you may experience
some minor glitches with the appearance of jGnash depending on the version installed and fonts
available.

If in doubt, install Java™ 8 or newer and configure your system accordingly.

After Java is installed, you are ready to install jGnash. Simply open the zip file and extract the jGnash
directory and it’s complete contents to a directory of your choice, and do not alter the files or locations.
I usually create a directory named "bin" in my home directory and keep the jGnash directory in it to
better organize my computer. When upgrading between versions of jGnash, do not unzip to the same
location and overwrite the existing files. Use a new location or delete the existing files first.

2.3. Starting jGnash
After the jGnash directory has been extracted from the zip file, you should see several files in the
directory. Of interest at this point are the jar and exe files.

If you are running on a Windows™ based computer, you can simply double click on the jGnashFx.exe
file to start jGnash. Alternatively, you can also double click on the bin/jgnash-fx.bat file as an alternate
means for starting the application in a console so that logging messages are visible.

If you are running on a Un*x or BSD based system you can start jGnash from a terminal as shown
below using the included Bash script. You can also create your own application launcher using the
Bash script in your desktop environment of choice.

./jGnashFx

jGnash has several advanced features such as running as a portable application or using jGnash as a
multi-user home networked application. These advanced features are accessible via the command line.
Please see Command Line Options for more details.

2.4. Running for the First Time
A license acceptance screen will be displayed the first time you start jGnash. jGnash will not run unless
the license is accepted. The short of the license agreement is jGnash is a freely available program
comprised of other freely available software, and should anything bad happen during use, the authors
involved are not libel for any damages. The license also details how jGnash may be distributed and

4
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used.

If the license agreement sounds daunting, take a look at the license agreements of commercially
available personal finance applications and you will see similar agreements. Myself and just
about every other person making software available for free or purchase tries their best to
ensure the software they create works well and as intended. Sometimes bugs do creep in and it
does not work quite as planned. The advantage of free software is you generally have direct
access to the authors, and you have a much larger voice in helping the application grow and
evolve over time.

2.5. Getting Help and Giving Back
The intent of this user guide is to get you off to a good start using jGnash. Despite my best attempts,
there are those who need a little bit of extra help or have a special need or circumstance and require
the help of others that have already been around the block a few times.

The best place to start is the jGnash user group hosted at http://groups.google.com/group/jgnash-user
[http://groups.google.com/group/jgnash-user]. The user group contains a well rounded group of individuals
who can help answer just about any question. As a courtesy to others, I encourage you to search the
group prior to asking a question to see if it’s already been answered.

If you have found a bug, or have suggestions for improvement, the group page has links to a bug and
feature request tracker that can be used to log and track your requests. The group forum can be used
to post a bug or request, but use of the tracker ensures the request is not lost in the mix of discussions.

If you are well versed in use of jGnash and other personal finance applications, you are encouraged to
give back a little time and contribute your experience to the group and help others.

5
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Chapter 3. Getting Started
The basic elements of jGnash are Accounts, Currencies, Securites, and Transactions. Every account is
assigned one currency and every transaction is associated with at least one account. Investment
Accounts and Investment Transactions will be associated with a Security.

jGnash supports various Account types that can be arranged into a flexible hierarchical structure. The
Accounts may be arranged by financial institution, by type, or some other structure. It’s good practice
to organize your Income and Expense Accounts into a logic arrangement that allows you to drill down
into a layer of more detail.

The balance of an Account will roll up into it’s parent Account within the Accounts view as well as in
some reports.

Below is a typical Expense Account arrangement that allows you to differentiate between different
type of automotive and food related expenses, but roll them up into more macro level expenses.

• Expense Accounts

◦ Automobile

▪ Fuel

▪ Insurance

▪ Service

◦ Food

▪ Dining Out

▪ Groceries

Transactions are used to record daily expenditures as well as income from the sale of personal items,
investments, or paychecks.

If you are familiar with other personal finance applications, you may notice that jGnash uses income
and expense accounts instead of income and expense categories. Functionally, there is no difference,
other than jGnash allows you see a detailed transaction register of the income and expense accounts as
easily as you would look at your bank accounts.

3.1. Editing Environment
The jGnash editing environment is not much different then in other application with the exception that
it provides a few shortcuts to speed up entry of transactions.

jGnash knows and understands just about any known locale and country setting. Depending on your
settings, the decimal symbol will change accordingly as well as the displayed format of dates.

7



3.1.1. Date Fields

The date field is freely editable and jGnash will make the best attempt at interpreting an invalid entry,
but the results are indeterminate. Clicking on the button to the right of the field will display a calendar
dialog where you can select a date as well.

The field is flexible enough to allow use of multiple keys as the field separators regardless of the
current locale. This is done to make entry easier on compact keyboards. The usable field separator
characters are defined in the table below.

Also, dates can be modified using the keyboard shortcuts defined below.

Table 1. Date Entry Shortcut Keys

Keys / Mouse Function

+, ↑, Mouse Scroll Up Increase the date by one day

-, ↓, Mouse Scroll Down Decrease the date by one day

PgUp, Mouse Thumb Wheel Up Increase the date by one month

PgDn, Mouse Thumb Wheel Down Decrease the date by one month

t, T Change to today’s date

,, ., /, \ Valid field separator for all locales

3.1.2. Number Fields

Numerical entry in jGnash is as easy as typing the desired value into the field. Decimal separators are
handled according to the configured locale.

 

You may also enter arithmetic operators and calculate values within the entry field.

The arithmetic operators that may be used are () + − ∗ /.

Traditional arithmetic operator precedence is followed for all calculations.
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3.2. Creating a New File
When you start jGnash for the first time, you will be presented with a very simple screen. At the
bottom of the screen, program notifications and memory consumption information are displayed.

Creating a new file is done in 5 steps using the wizard

1. Create a new file using the File › New command and follow the prompts in the new file wizard.
When given the choice to select the storage type, leave it as the default value for now. A default file
name and location will be provided that you can change if desired. If the file already exists, you
will be warned you are about to overwrite it.

2. After selecting the storage type and file name, you will be asked to choose the default currency. The
default currency can be changed at a latter time, and if for some reason your currency of choice is
not available, you can create a custom currency and set it as the default after the file is created.

3. Next you can choose the currencies that are available for use. Currencies may be added and
removed as needed at a later time if needed.

If needed, custom currencies may be added using the Currencies › Add/Remove command. As
locales change, default currency availability will change as Java is updated. The typical need for a
custom currency is to support legacy accounting information as countries standardize on the Euro.

4. After choosing the available currencies, default accounts can be selected if desired. If you are new
to personal finance software, the defaults will be a good starting point. The accounts structure can
be easily changed as needed to accommodate your own personal needs.

5. The last step is the Summary page of the wizard. Verify everything is to your liking and click on the
Finish button to create your new file.

After the file is created, you are now ready to change, add, or remove accounts as need and begin
entering transactions.

Encryption and password protection options do not exist in jGnash with the exception of a clear
text password for client/server operation.

Encryption becomes a sticky subject when it involves exporting and distributing software
throughout the world. jGnash is designed to support many nationalities, so control of
distribution would be become very difficult if encryption was integrated.

If you do have the desire to encrypt your jGnash data, the best choice is to use the encryption
capabilities of your operating system or install a freely available third party encryption tool.

3.2.1. File Types

jGnash supports different file types for storing data. File types can be easily changed by using the File ›
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Save As command and naming the new file with the appropriate file extension.

The current file will be saved in the new format and automatically opened.

Regardless of file type used, jGnash automatically saves the data if changed every 30 seconds to
minimize the chance of accidental data loss.


Client/Server

If you are using jGnash in the Client/Server mode, all changes are committed
immediately.

3.2.2. H2 and HyperSql Relational Database

An H2 or HyperSql relational database is required when using the client / server functionality of
jGnash. jGnash embeds the database server so that no additional configuration or installation of
software is required to use a relational database.

The relational database may be used for a single user. If startup and shutdown performance is
important to you, then the binary file format described below is a better choice.

The advantage of the relational database outside the requirement for client / server capability is the
ability to use several available tools to browse and query your jGnash data. Also, a relational database
will be more fault tolerant of system crashes or power outages vs. use of an XML or Binary file.

The disadvantage of the relational database is a bit slower operation and more memory consumption.

If using the H2 Database and operating over a network using Client/Server mode, you have the option
of enabling encryption for network communication. This will not encrypt your database file. See the
Command line options for specifics.


Database Administrator

The default administrator for a jGnash relational databases is JGNASH and is not
configurable at this time.

3.2.3. XML File

XML file format is human readable and easily read by other applications at the expense of a
considerably larger file size. Memory usage is less when using the XML file format, but certain
operations may take longer. The advantage of the XML file is easier parsing and manipulation of the
file using another program external to jGnash. If you have a large amount of data, jGnash will use less
system memory when using the XML file format.


Backups

The XML format is also used for saving automatic backups of jGnash files if enabled.
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3.2.4. Binary File

The binary file format is the most compact file format and will open and close the quickest. This is the
recommended file format if you do not need client / server functionality and you are using a laptop or
a workstaion with a UPS.

3.3. Accounts
Accounts are what you use to organize how you save and spend your money, and where it comes from.
Account structures can be changed to organize the display of information to suit your specific needs.

Typically, you will have a separate jGnash account for each savings, checking, investment account, etc.
that you have at a financial institution. Accounts can be organized under "placeholder" accounts to add
different levels of organization.

For example, if you would like to see a summary of your accounts by financial institution, you can
create a placeholder account that represents a single financial institution and group your savings and
checking accounts from that particular institution.

Maybe you want to see all savings accounts grouped together and checking accounts grouped together.
It’s just a mater of creating placeholder accounts for checking and savings and placing the respective
accounts under them.

The account structure can be easily changed at any time with the exception of removing accounts after
they have transaction in them. Transactions must be manually deleted from an account before you can
remove it.

3.3.1. Creating Accounts

A new account is created by clicking on the [ New ] button in the account list view.

A new dialog box will be displayed that allows you to create a new account to suit your particular
needs.
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Account Information

Name

The name for the account. The name will be used to identify the account when creating
transactions. Account names do not have to be unique, but may not be left blank.

Description

A description for the account. This field may be left blank if desired.

Account Number

The Account Number field is generally used for storing the account number provided by your
financial institution. This field may be left blank if desired.

Account Code (General Ledger Code)

The Account Code field will default to a value of 0 and must be a numerical value. This value will
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also control the displayed order of accounts within the same branch. If the account code is left as a
value of zero, sort order will be deferred to an alphanumeric sort against the account names. Best
practice is to either use an assigned Account Code for all accounts within the same branch or leave
the code as a value of 0 for all accounts. Otherwise, sort order may appear to be random.

Bank ID

This is the identification number of the financial institution and is generally used as an identifier
when importing OFX files. This field may be left blank if desired.

Currency

The currency for the account. Account currencies cannot be changed if the account contains
transactions.

Securities

This button will display a dialog that allows you to add and remove the available Securities for the
account. This applies only to Investment accounts.

Account Type

Account Type determines what the account can be used for and the type of transactions that can be
created. An Account’s type may be changed after it is created to another type only if it is similar in
function. For example, an Investment Account can be change to a Mutual Fund account and vice-
versa, buy they may not be changed into Bank or Credit accounts.

Account Options

Locked

If selected, the account will be locked and further changes will be prevented. This is useful to lock
accounts that have been closed while retaining your historical data.

Placeholder

If selected, child accounts may be placed under this account and the account will not accept
transactions. This is useful for organizing accounts into a hierarchical structure.

Hide Account

If selected, the account is hidden from view if the hide account filter is enabled.

Exclude From Budgets

If selected, the account is hidden from view of the budgeting tool.

Parent Account

Clicking on this button will display a dialog that lets you select the account this account resides
under. If you want the account to be placed at the top most level, then choose the Root account as
the parent. Parent accounts may be changed as needed to suit your needs.

Notes

Room for extra information about the account if desired.
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At any later time, the [ Modify ] button may be used to change an existing account. If the account
contains transactions, certain options may not be changed.



jGnash does not have a place to specify an opening balance in keeping with correct
practices for double entry accounting.

However, it is still possible to set and opening balance:

To add an opening balance, create a transaction with an appropriate deposit or
withdrawal against an Equity Account of your choice. Most people will choose or
create an "Opening Balance" account.

This follows well known accounting practices.

If you are not concerned about correct accounting practices, you can create an
Adjustment Transaction instead.

3.4. Account Types
jGnash allows use of several account types to make organization easier. The account type chosen can
have a significant impact on how reports are generated and displayed, and the types of transactions
you can create.

3.4.1. Asset

Asset accounts are intended to be used to track the value of durable items such as houses, cars, boats,
collections, etc. Value of items can be adjusted over time against Income accounts to show gain or loss
of value. If you were to sell an item and convert it cash, the sale of the item can be tracked against the
Asset accounts containing the item.

3.4.2. Bank

Bank accounts are used for the savings accounts you would have at a bank.

3.4.3. Cash

Cash accounts represent the cash you carry with you. Cash accounts are also good for representing
deposits and withdrawals from Flexible Spending Accounts.

3.4.4. Checking

Checking accounts are used for the checking account you would have at a bank.
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3.4.5. Credit

Credit accounts are used to record purchases and payments made to a credit card account. Credit
accounts are primary used for short-term liabilities and great for representing overdraft and line of
credit accounts at banks.

3.4.6. Equity

Equity accounts are used to record opening account balances against. Typically, you will have only one
Equity account. Equity accounts are representative of another accounts net worth at the time you
begin tracking it’s value.

3.4.7. Expense

Expense accounts are used to record expenses such as food, utilities, taxes, investment expenses, etc.

3.4.8. Income

Income accounts are used to record income such as salary, dividends, investment income, etc.

3.4.9. Investment

Investment accounts are used to buy and sell Securities. Investment accounts can be used to track
401k, IRA’s, etc.

• Investment Accounts have a cash balance if you buy or sell transactions against the account.

• Investment purchases and sales fees can be made against the cash balance of the investment
account or other specified accounts.

• Multiple investment fee entries per transaction may be entered.

• Multiple gains/loss entries per transaction may be entered.

• Investment Accounts support multiple securities.

• Investment Accounts can be used to model an on-line brokerage account.

3.4.10. Liability

Liability accounts are used to track long term loans or liabilities. Liability accounts have the added
feature of allowing you to set-up a loan payment that takes some of the effort out of entering periodic
loan payment transactions.

3.4.11. Money Market

Money Market accounts are typically a high interest yield account with withdrawal rules or
limitations. They are generally used for long term savings accounts with the intent of keeping your
cash readily accessible.
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3.4.12. Mutual Fund

Mutual fund accounts are a specialized version of an Investment account and generally used to track
mutual fund type investments.

3.4.13. Simple Investment

Simple investment accounts are for investments where you do not actively manage or are able to track
purchases and sales of securities. The typical scenario would be a company pension plan that only
provides cash balance information. Sometimes, these types of investment accounts are called
Annuities or Guaranteed Retirement Accounts

3.4.14. Root

The root account is the top level account that holds all other accounts. You cannot remove or modify
the root account. Normally, it is not visible unless you are changing the account structure.
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3.5. Entering Transactions
jGnash follows well know double entry accounting practices while reducing the complexity of
transaction entry.

If you are familiar with other personal finance applications, you may notice that jGnash uses income
and expense accounts instead of income and expense categories. Functionally, there is no difference,
other than jGnash allows you see a detailed transaction register of the income and expense accounts as
easily as you would look at your bank accounts.

When creating your file, if you selected the available default accounts, you will have income and
expense accounts to work with. These accounts can be changed to suit your needs at any time.

The benefit of double entry accounting in jGnash is the ability to use reports and charts to see where
your money is going and coming from. Single entry transactions hide those details and make tracking
difficult and tedious.

For simplicty, the terms used here to discuss changes in account balances will be Increase and
Decrease.

Business accounting practices use the Credit and Debit terms which can appear to be backwards
depending on account type and cause confusion for those who are not familiar.

3.5.1. Common Transaction Properties

The properties below are common to all basic transaction types. Investment transactions will require
additional information not covered in this section.

Payee

The Payee is almost always the name of a person or business. The Payee field may be empty, but it is
good practice to always use a payee for a transaction entry. jGnash will automatically learn and
autocomplete a transaction using the Payee field. This helps aid speed of transaction entry and helps to
establish consistency making searching and filter much easier.

Number

A transaction may be assigned a number or abbreviated description. If working with a Checking
account, the number is almost always the same as the check number you wrote. Use of a check number
also makes reconciliation against a bank statement easier.

Date

Every transaction has a date. The date is usually the date the transaction occurred. Some people will
choose to edit the transaction to match the posting date.
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Please review the Date Fields shortcuts that may be used to save a significant amount of time when
selecting and editing dates.


jGnash also maintains an internal timestamp for the actual date and time the
transaction was created or last modified for auditing and tracking purposes.

Memo

The Memo is a brief description of the transaction so you can remember what it was. jGnash will
automatically learn the Memos you commonly use. This helps aid speed of transaction entry and helps
to establish consistency making searching and filter much easier.

Split transactions have an option to Concatenate or automatically merge the Memos of the split entries.

Amount

This is the transaction amount. If entering a multi-currency transaction, this field will be expanded to
handle the correct exchange of currencies.

The Number Fields section details how to enter amounts using mathematical operations in the same
manner as a calculator.

Reconciliation State

The Cleared CheckBox at the bottom of the register form is a tri-state box that allows you to toggle
through all three of the reconciliation states described below.

A jGnash transaction has three reconciliation states

Not Reconciled

The transaction has not been reconciled against a bank or online statement

Cleared

The intended use is for manual reconcilation of a specific transaction prior to a full reconcilation
for the period.

Reconciled

The transaction has been reconciled manually or through use of the Reconcilation tool

Transaction Attachments

jGnash allows the attachment of an image file to the transaction using the chain link button at the
bottom of the transaction form. The attachment will be moved to a managed directory call attachments
located in the same directory as your jGnash file. The eye button allows you to view the attachment
and the broken chain loop button allows for removal of the attachment.

18



3.5.2. Double Entry Transactions

A double entry transaction follows standard accounting practices. A double entry transaction will
always increase the balance of one account and decrease the balance of another account. The amount
of the change will always equal and opposite in value.

Double entry transactions using accounts with different currencies will not be equal and
opposite numerically due to exchange rates between currencies. jGnash automatically handles
the difficult part of the currency exchange within the transaction.

A double entry transaction normally begins within the register of some type of Cash or Bank account.
In the example below, a Withdrawal is being made from a Cash account. The balance of the account
will be decreased by 25.67 and the balance of the Expense Account Automobile:Fuel will be increased
by 25.67.

The account to withdraw funds from (Decrease) or deposit to (Increase) is selected in the Account
ComboBox.
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3.5.3. Split Entry Transaction

A Split Entry Transaction is a Double Entry Transaction, but the amount is split across multiple
accounts.

A Split Entry Transaction is started by clicking the [ Splits ] Button. A dialog will be shown that allows
an entry for multiple accounts to be made.

Notice the [ Concatenate Memos ] Checkbox. If the Checkbox is selected, the Transaction memo will be
a generated list of the unique memos of the split entries. This saves entry time for the Transaction and
reduces the file size.

Editing of the Transaction amount will be disabled as it is the sum of the Entries. The Memo field will
be disabled as well if the [ Concatenate Memos ] in the Split Transaction dialog was selected.

If a memo is not entered for a Split Transaction and the [ Concatenate Memos ] button is not selected,
the Transactions register will display the memo of the first Split Entry.

A Split Transaction may consist of multiple Deposits and Withdrawals as shown below. This is a typical
example of a paycheck where insurance and taxes are deducted from the gross salary.
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3.5.4. Single Entry / Adjustment Transaction

A Single Entry Transaction is primarily used to fudge an Account balance when you simply don’t have
the information to correctly balance the account.

In the example below, you can see a negative amount of -1.23 was used to decrease the balance of the
account.

The half black and half white circular button at the bottom of the form is a utility to help convert the
Single Entry transaction into a Double Entry Transaction after you find the needed information.
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3.5.5. Transfer Transaction

The Transfer tab provides a slightly faster way to move money between accounts without requiring as
much information. If go back to edit the Transaction, the edits will be performed within the Deposit or
Withdrawal forms.

3.6. Investment Accounts
Investment Accounts need to be populated correctly if the Portfolio report is to work correctly.

• Accounts with prior history should purchase securities from the "Opening Balance" Equity account.
Ensure the quantity of securites is correct and use the current price.

• Cash balances should be transfers from the "Opening Balance" Equity account.

• Dividends, sells, etc. should occur after opening securities and cash balances are established.
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Chapter 4. Budgets
jGnash has a budgeting feature that makes it easy for you to define spending and income goals by
account and bump those goals up against your actual transactions. A compact graphical overview of
each budgeting period is provided to highlight how well you are following your budget based on
selectable periods.

Tracking how well you follow your budget can be an eye opening experience and can lead to better
financial health.

Budget Features
• Multiple budgets are supported and may be copied making it easy to try out different scenarios and

create year specific budgets if desired.

• Allowed accounts for budget are limited to Income and Expense accounts.

• Accounts may be excluded from budgets by setting the exclude flag in the account properties
dialog. Sub-accounts will not be displayed if the parent account is excluded.

• The reporting period for budgets may be daily, weekly, bi-weekly, monthly, or quarterly and can be
changed as needed.

• The per account budget goals may also be entered in daily, weekly, bi-weekly, monthly, or quarterly
periods and are independent of the budget reporting period.

• The budget may be exported to a spreadsheet.



Budget Periods

The reported period of the budget is independent of the per account budget goal
period.

Example: Your salary is paid in bi-weekly intervals, but you want to see your budget
reported by month. You can change the period for the income account to weekly or
daily and enter your salary.

When reported by month, jGnash automatically handles the difference in the periods
1and distributes your bi-weekly salary income across monthly boundaries.

4.1. Graphical Overview
The main budget panel is shown below.
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The width of the account column is adjustable by placing the cursor between the Account header and
the period header columns and then clicking and dragging the mouse cursor right or left.

At the top of the panel, a toolbar exists that allows you to change how much information is displayed,
modify the budgets, and export the active budget to a spreadsheet.

The budget drop down list lets you quickly select between different budgets you have created. The
[ Budget Manager ] button displays a dialog that let you create, duplicate, and delete budgets.

The [ Properties ] button will display the dialog shown below with various options for the active
budget.
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The period used for the budget display can be changed in this dialog as well as the budget description.
You may also select the account groups that are visible for the selected budget.

The year spinner allows you to bump the selected budget up against the selected year’s transaction
data. The selected year also effects the calendar periods when editing period amounts.

Double clicking on an account name to the left of the panel will display a dialog that allows you to
change the account specific budget period and period amounts.
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The Smart Fill panel may used to enter repeating patterns or fill in the amounts automatically based on
the last 12 months. Alternatively, you may directly edit the amount of each period by clicking and
typing in a table cell.

The per account budget amounts as well as the *Change * and *Remaining * values are hierarchical in
that the values of the child account are summed and are added to the parent account. If a parent
account is not configured has a placeholder, it may also be assigned period goals that are inclusive of
any children.

At the bottom of each reported budget period, a summary by account group is displayed. To the right, a
summary by account is displayed. The summary’s made be disabled if desired by unselecting the
appropriate checkboxes.

The [ Export Spreadsheet ] button will export a file to your choice of an xls or xlsx file. The exported
spreadsheet does contain formulas which makes it easier to manipulate the file externally.

4.2. Budgeting Tips
When planing a budget, you need to consider how you spend and receive your money versus how you
want to report your budget.

jGnash has to make assumptions when entering per account period amounts. Internally, jGnash is
keeping a list of 366 days (365 + 1 leap day) per account with the list starting at the first calendar day of
the year.

When a period goal for an account is entered, the amount is averaged across each day of the period.
Entry of amounts is also sensitive to the current year. If you select Monthly for the account period, the
monthly boundary for days is established by the current year calendar months and the amount is then
averaged across the number of days per each month.

Averaging of periods has an impact on how exact the tracking of your budget is. If you choose to enter
a monthly average for income, but are paid on certain days on the month, your budget will show slight
variations through the year.

If you want the budgeted vs. Remaining amounts to be exact for a particular account, then you will
want to set the account period to be Daily and take the effort to enter your daily amount goals.

You will not be able to export a spreadsheet when the report period is daily due to memory
requirements and limitations of some spreadsheet applications.
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Chapter 5. Reconciliation
Reconciliation is a simple and visual process of matching up the transactions listed in an account’s
register against a paper or electronic statement provided by a financial institution. If differences do
exist, then any missing or erroneous transactions must be addressed until the differences are resolved.
Statements should come from you bank, investment broker, credit card issuer, etc. on a periodic basis.

Periodically reconciling an account helps ensure transaction entry errors do not creep in over time.
Reconciliation is also a great tool for monitoring your accounts for fraudulent transactions.

Accounts may be reconciled using a manual process or using the Reconciliation Wizard. For any given
reconciliation period, using a combination of both methods will be difficult.

Regardless of the Reconciliation process used, it is good practice to reconcile all accounts periodically.

5.1. Basics
Every transaction entry will have two independent reconciliation states that applies to both of the
related crediting and debiting accounts. Split transactions may have even more reconciliation states
depending on how many accounts it touches. Reconciliation states are explained a bit later in this
chapter.

The default assumed reconciliation states can be configured depending on your preferred method of
reconciliation. Taking time to understand these options is important for a successful reconciliation
process.

By default, jGnash comes configured to favor use of the Reconciliation Wizard.


If this is your first time reconciling an account and you have prior transaction history
with a mix of Reconciled and Cleared transactions, you may need to manually
reconcile prior transaction history.

5.1.1. Reconcile Settings

jGnash makes it easier to manage reconciliation by providing some options described below. These can

be access in the Register options tabs using the Tools › Options menu.
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Unless you have very specific needs, it is recommend that you choose to have the option All
transaction accounts have same reconciled state or Automatically reconcile Income and Expense
Accounts selected as the default.

Selecting Automatically reconcile Income and Expense Accounts requires a bit more work on your
part in that you are required to reconcile all institution statements, but it will not create any issues
when transferring between accounts. This is the recommended option if you are using the Reconciliation
Wizard.

Selecting All transaction accounts have same reconciled state will reduce the effort of reconciling
transactions, but can create problems reconciling transfers between bank accounts later. If you
manually reconcile your accounts and do not use the Reconciliation Wizard, this option saves a
significant amount of work at the risk of making an assuming a transaction occurred correctly
between two institutions. Use of this option in conjunction with use of the Reconciliation Wizard can
create problems with bank transfers when you reconcile both accounts.

Choosing to disable automatic reconciliation will require you to reconcile Income and Expense
accounts for which you may not have been provided a reconciliation statement.

5.1.2. Reconcile States

jGnash transactions have three reconciliation states that are presented in order below:

Not Reconciled

The transaction has not been cleared or reconciled.

Cleared

The transaction has been marked by the user to have been cleared during a manual or unfinished
reconciliation process. A transaction may be marked as cleared to draw attention to it without
impairing use of the reconciliation wizard.

Reconciled

The transaction has been reconciled or manually reconciled.

Manually marking transactions is not recommended if you are going to use the Reconcile
Wizard.
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5.2. Manual Reconciliation
Manual reconciliation is the process of individually comparing the account register against the
institution provided statement and marking the matching transactions as reconciled.

The downside to manual reconciliation is not all checks and balances are performed against the
reported opening and closing balance for a given period. This increases the likely-hood of missing a
recorded transaction or incorrectly entered amount.

To manually mark a transaction as reconciled, use the context menu in the register to display options
to change the reconciled state.

Use of the context menu is currently the only means of marking a transaction as reconciled other
than using the reconciliation tool. It may also be used to clear transaction erroneously marked as
reconciled.

Transactions may also be marked as Cleared through the transaction form. Some users may prefer to
clear certain transactions manually during a given period to draw attention to them. Cleared
transactions will still be visible within the Reconciliation Wizard if used later while manually
Reconciled transactions will not.

5.3. Reconciliation Wizard
Use of the Reconciliation Wizard helps to simplify the reconciliation process by comparing opening
and closing balances reported by the institution against the sum of the transactions as you mark them
as reconciled. You receive instantaneous visual feedback as you mark transactions, and at the end of
the process you should have a net difference of zero.
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The Reconcile Wizard has a nice feature that is not immediately obvious. While the wizard is
displayed, you can still go back to the account register and enter missing transactions, correct
erroneous amounts, or modify and delete transactions if entered into the wrong account. The
Wizard’s credit and debit lists are fully dynamic. You are not required to exit the Wizard without
completing the process if you discover missing transactions or errors.

The image of the account register shown next is representative of a small but typical reconciliation
period. The amounts and balances shown correspond with the other images as the Reconcile Wizard is
explained in this chapter. Refer back to this image as necessary for clarification.

Take note of the Reconciled Balance: $2,614.43 and that it is the last transaction marked as reconciled.
Also, take note of the transaction dated 03/25/14 and the corresponding balance of $1,369.70. You will
see these same values later in the Reconcile Settings dialog.

The Reconcile Wizard is started by using the context menu in the Account List, or by clicking the
[ Reconcile ] button in the transaction register.

A small dialog will be shown requesting some information.

Statement Date

This is the closing date for the reconciliation period. This should be reported on your account
statement. The date will typically be the end of the month, but may be different due to institution or
locale rules. Transactions entered after this date will not appear within the Reconciliation Wizard

Opening Balance

The opening balance should also be provided by your institution and should be equal to the closing
balance of the last reconciliation period. In your account register, this will also be the account
balance of the last reconciled transaction.

Ending Balance
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This amount should also be provided by you institution.

These values should be provided to you by your banking institution in paper or electronic format and it’s
important these values are entered correctly, otherwise balances will not zero out.

Pay special attention to the account type, the selected option for Reverse Displayed Account Balances
and if you are entering a positive or negative opening and ending balance.

After clicking the [ OK ] button, the settings dialog will be replaced by a dialog showing all of the
transactions prior and inclusive of the statement date that have not been marked as Reconciled.
Transactions marked as cleared will be shown.

The next step is to go through the institution provided statement and mark every matching transaction
as reconcilable by clicking on the transactions. As you click each transaction, totals will update and you
should see the Difference value approach zero. The symbol in the Clr column will also change when
marked as Reconciled. When the Difference is zero, the [ Finish ] button will become active.
Transactions marked as cleared will also need to be selected if they are to be reconciled.

It is not unusual to find transactions that go unmarked for reconciliation near the end of the statement
period. These are transactions you have entered that were not processed through the system fast
enough to show up on your statement and impact your account balance. Simply ignore these
transactions and they will be captured at the start of the next statement and reconciliation cycle.
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Clicking on the [ Finish ] button will close the dialog and will mark the selected transactions as
Reconciled. Depending on the number of transactions and type of file format being used, it could take
awhile for the changes to be saved. A wait message will be displayed during the change process.

What do you do if you have marked all transactions as reconciled and the difference is not zero?

• Not all paper and electronic statements clearly identify fees, earned interest, etc. Make sure you
have captured these transactions.

• Were any transactions amounts entered incorrectly?

• Transactions manually marked as Reconciled during the statement period will not show in the
transaction columns and are guaranteed to throw off balances. Mark the transactions as Cleared
instead.

• Do you have your Reconcile Settings configured appropriately for the process you are using? If in
doubt, use Automatically reconcile Income and Expense Accounts.

• Incorrectly entered opening and ending balances will cause errors in calculated balances.

If you need to to exit the Reconciliation Wizard before finishing, the [ Finish Later ] button may be
used. This will close the dialog and mark selected transactions as Cleared. This makes it easy to restart
the process with transaction you have already marked as reconcilable identified. You will still need to
reselect those transactions when you restart the process.
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Chapter 6. Importing Transactions
Importing of OFX, QFX, MT940, and QIF transaction files is supported within jGnash. The files are
downloaded manually from your financial institution and then imported. jGnash does not currently
support an automatic download process.

QIF is an old format that was not well defined and is generated inconsistently between financial
institutions. There are two significantly different formats with one consisting of transnational data
only and the other format attempts to serve as an export / import format with account information for
financial applications. Use of date formats within the QIF format will vary and can lead to incorrect or
failed import of transactions. If at all possible, avoid use of QIF files and use an OFX or QFX file.

OFX and QFX files are a well defined standard and jGnash will easily process these. This is the
preferred file format for importing transactions into jGnash. OFX and QFX files are XML based and
human readable in that you can open the file with a text editor and easily understand the information
contained within.

MT940 is another well defined standard commonly used between financial institutions. The format
consists of fields separated by colons and commas with well defined numeric codes. MT940 is very
compact and efficient to transfer electronically.


The Import Process below describes the basic import of transactions. jGnash can also
process OFX and QFX files with Investment transactions. Additional columns will be
present and enabled when applicable for these advanced types of transactions.

6.1. Import Process

Importing transactions is an easy process that is guided with a simple wizard. It begins with File ›
Import › OFX / QFX, File › Import › QIF, or File › Import › MT940 and selecting a file that has been
downloaded.

The first step of the import process requires selecting the correct account the import file is for. This is
the base account all imported transactions will be associated with.


When importing OFX or QFX files, jGnash will preselect the correct account after it
has learned from the first import.

The second step of the process is reviewing the transactions as shown below.
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The first column consists of import status symbols:

• A plus symbol indicates the transaction has been detected as new. Double clicking on it will change
it to a negative symbol to indicate you do not want it to be imported.

• An equals symbol indicates the transaction has been detected as a duplicate of a manually entered
transaction or already imported transaction. Double clicking on it will change it to a plus symbol to
indicate you want to force the import of the transaction.

The second, third, and forth columns are not editable. The Payee and Memo columns may be
preprocessed using JavaScript Filters as described later.

The Account column can be double clicked and changed to suit. The selected account will normally be
an income or expense account unless it was a transfer to another bank account or financial institution.
This column is also the equivalent to Categories for some other financial applications.

The Amount column can be double clicked and edited. This is normally not needed and not
recommended, but allowed for some specialized uses when working with multiple currencies.

The [ Delete ] button may also be used to remove a transaction being imported.

When importing transactions, jGnash uses what is called a Naive Bayes Classifier to help
preselect the best account for the transaction. Consistent use of memo and payee fields will help
accuracy of account selection. Accuracy also improves with increased quantity of transactions
over time.
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The last step of the Import Wizard allows you to review basic information about the import before
committing to the changes. After clicking on [ Finish ], the dialog will close and jGnash will begin the
import process.

6.2. OFX imports
Taking the time to correctly configure your jGnash Account properties can help reduce the effort
needed to automatically identify Accounts when importing OFX transactions.

OFX files may contain enough information to identify transfers between accounts. Most financial
institutions will correctly identify transactions between checking and savings accounts with the bank,
but others may include enough information when transferring between finance institutions.

Below is a fragment of the OFX file content defining the transfer. jGnash will attempt to match the
<ACCTID> identifier to an existing Account Number that is specified within the properties of your
jGnash account.

 <BANKACCTTO>
    <BANKID>100000009
    <BRANCHID>TEST
    <ACCTID>555555-C01 ①
    <ACCTTYPE>CHECKING
</BANKACCTTO>

① Account identifier

The Account Number is easily changed by modifying the Account properties as described in the
Creating Accounts section of the manual.

6.3. JavaScript Filters
When importing transactions from OFX/QFX, mt940, and QIF bank statements downloads, transactions
may be preprocessed using custom JavaScript files. As of jGnash release 2.32.0, the scripts may be used
to alter the memo or payee of the transactions being imported.

You have three options for making a JavaScript file available for use:

1. Some scripts are included by default. These show up as /jgnash/imports/xxx.js in the Script column
of the table.

2. Place the JavaScript file into a importScripts sub directory where your jGnash data file is installed.

3. Place the JAR file into your home directly where jGnash will find it.

a. $HOME/.jgnash/importScripts for UNIX and BSD based operating systems.

b. USER_HOME\AppData\Local\jgnash\importScripts for Windows operating systems.

These import scripts must be specifically enabled for use and the order in which they will be executed
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can be changed using the Tools › Configure Transaction Imports Filters… menu as shown below.
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Below is an example JavaScript file. The first four functions are required for correct operation.

The first function accepts an ImportTransaction for advanced manipulation of the imported data.

The second and third functions accept a string and are expected to return a string.

The getDescription function should return a meaningful description of the script.

/* Normalizes the case of the payee and memo fields */

// place holder for the passed ImportTransaction
var importTransaction;

// This will be called first and passed the ImportTransaction
function acceptTransaction(transaction) {

    // does nothing with it in this script
    importTransaction = transaction;
}

// This is a required function
function processMemo(memo) {
    return capitalizeFirstLetter(memo.toLocaleLowerCase());
}

// This is a required function
function processPayee(payee) {
    return titleCase(payee.toLocaleLowerCase());
}

// This is a required function
var getDescription = function (locale) {
    var Locale = Packages.java.util.Locale;

    switch (locale) {
        case Locale.ENGLISH:
            return "Tidy Memo and Payee fields";
        default:
            return "Tidy Memo and Payee fields";
    }
};

// Capitalizes the first letter or a String
function capitalizeFirstLetter(str) {
    return str.charAt(0).toUpperCase() + str.slice(1);
}

// Converts a string to Title Case
function titleCase(str) {
    return str.replace(/(^|\s)[a-z]/g,function(f){return f.toUpperCase();});
}

The full jGnash API may be accessed within these scripts for advanced processing capabilities. See the
JavaScript section of the manual for more details.
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
JavaScript files are expected to be encoded as UTF-8 Files. An incorrect file encoding
may cause script failures.

38



Chapter 7. Reports
A variety of reports exist that present your financial history and status in different ways. There are
currently three classes of reports available. Text reports can be exported and easily imported into a
spreadsheet for advanced manipulation. Chart based reports may be altered and exported to a graphic
file, or printed using the context sensitive pop-up menu. Tabular type reports may be printed or saved
to various file formats including CSV or PDF files.

7.1. Tabular Reports
Tabular reports are displayed in a specialized viewer that allows you to change the page and print or
export the report. The font size of the displayed report can be changed from the toolbar of the report
window.

The fonts used to display the report may be changed in the Tools › Options dialog shown below. The
Proportional font is typically used for report headers and footers. The Monospace font, also called a
fixed-width font, is used to display the reported values.

If a proportional spaced font is chosen for the Monospace font, numeric report values may not line up
correctly in the report.



Font Information

Information on font types as well as a wide selection of freely available fonts can be
found on the Internet. Once a new font is properly installed in your operating system,
it will be available for use in jGnash the next time it is started.

7.2. Tips
Depending on your operating system, you may need to change the font type and font size to achieve
the best looking report. The font size can be changed on the report toolbar and is remember for each
report type.
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7.2.1. Nothing displays in the report and I’m not getting any errors

Try increasing your font size, and if that does not work, choose a different font. Depending on your
operation system, fonts may not render correctly at reduced sizes.

7.2.2. I get an error that tells me to reduce my font size

The selected font size is too large to display the report correctly. You will need to choose a smaller font
size. Many times, the column heading text may dictate the displayed width of a column. Try choosing a
proportional font with condensed spacing. You may also want to check the default paper size and
adjust if needed.

7.2.3. My PDF exports are missing information or don’t look correct on
different computers

Not all fonts are able to be embedded within a PDF file. You may need to experiment with different
fonts to achieve good portability. In most cases, the defaults jGnash chooses will give you good results.

7.2.4. The IRR is not being displayed in my Portfolio report

Your investment account may not be setup properly. Ensure that stocks have been added or purchased
prior to sells, buys, dividends, etc.
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Chapter 8. Administration
Several administration options and tools are provided to help with management of your data.

8.1. File | Save As
An open file may be saved as a new file of the same type, or a new file with a new file type. To save the
file as a different type, you must change the file extension to a supported type. Correct file extensions
are shown below.

Table 2. File Formats

XML File .xml

Binary File .bxds

H2 Relational Database (B-Tree) .h2.db

H2 Relational Database (MVStore) .mv.db

HyperSql (hslqb) Relational Database .script (.lobs, .log, .properties are used as support
files)

8.2. File | Export | Export Accounts and File | Import |
Import Accounts
Use of these commands allows you to export your account structure and import it back into and new
file. This is handy if you want to start a new file without manually recreating your accounts. This does
not preserve existing transactions.

8.3. Change Database Password
By default, when a new relational database is created, a password is not specified. This allows you to
password protect your file. This does not encrypt your data, so a person with the right tools can easily
access your data. It is useful for casual protection only. If encryption is important, use OS level
encryption capability available on any modern operating system. This is disabled while a file is open.

8.4. Shutdown Server
Issues a shutdown request to a remote server. This is disabled while a file is open.
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Chapter 9. Plugins and JavaScript
jGnash support the addition of JavaScript and Plugins to add additional functionality to the application.

9.1. Plugins
Plugins are tightly integrated into jGnash, and once loaded, behave as if they are a standard part of the
application. Plugins are coded in Java using a jGnash specific API as the entry point so they may be
loaded into jGnash.

Standard Plugins are packaged into JAR files and are located within the plugins directory located in the
directory jGnash is installed.

You have two options for manually installing a Plugin:

1. Place the JAR file into the plugins sub directory where jGnash is installed and restart jGnash.

2. Place the JAR file into your home directly where jGnash will find it.

a. $HOME/.jgnash/plugins for UNIX and BSD based operating systems.

b. USER_HOME\AppData\Local\jgnash\plugins for Windows operating systems.

The jGnash JavaDoc may be referenced if you are interested in creating a jGnash Plugin. The MT940
import is written as a standard Plugin and may be referenced as an example of how to write one.

9.2. JavaScript
In addition to use of Plugins, jGnash allows you to create and run JavaScript programs. The internals of
the jGnash engine and some user interface functions can be accessed to create custom reports, create
and modify transactions, etc.

Running a JavaScript program is as simple as using Tools › Run JavaScript command from the menu
bar.

Below is an example JavaScript program that displays the accounts in the currently loaded file and
demonstrates how to display a simple dialog. To try the program, create a text file using your favorite
editor with a name of your choice that ends with a .js extension. After creating the file, simply using

the Tools › Run JavaScript command to select the program and run it.
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load("nashorn:mozilla_compat.js");  // Load compatibility script

importPackage(javax.swing);
importPackage(Packages.jgnash.ui);
importPackage(Packages.jgnash.engine);

// helper function to print messages to the console
function debug(message) {
    java.lang.System.out.println(message);
}

// show the console dialog to see the debug information
var Console = Java.type("jgnash.uifx.views.main.ConsoleDialogController");
Console.show();

// this is how to get the default Engine instance
var engine = EngineFactory.getEngine(EngineFactory.DEFAULT);

// get a list of accounts
var accountList = engine.getAccountList();

// loop and print the account names to the console
for (var i = 0; i; accountList.size(); i++)
{
    var account = accountList.get(i);
    debug(account.getName());
}

// just to show how to use Swing
var optionPane = JOptionPane.showMessageDialog(null, 'Hello, world!');


JavaScript files are expected to be encoded as UTF-8 Files. An incorrect file encoding
may cause script failures.

JavaScript programs have the advantage of not requiring the use of an IDE or Java compiler to create
and test a program. The disadvantage is troubleshooting syntax and logic errors can be more difficult
than writing a jGnash Plugin.
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Chapter 10. Command Line Options
jGnash has several command line options for advanced users.

Options
--enableEDT

Primarily used for development and debugging the graphical user interface. When enabled, this
detects and warns of bad UI programing practice.

--file filename

Specifies a file to load at startup.

--opengl

Enables OpenGL support for platforms and video drivers that support it. Disable use if strange
graphics errors occur.

--xrender

Enables 2D rendering pipeline for modern X11 based desktop environments. The performance
improvement can be significant for some systems. This has no effect on OSX or Windows systems.

--portable

If portable is specified on the command line, jGnash preferences will be stored to a file
namepref.xmlinstead of using the system registry. Use of this option is intended for users who want
to run jGnash from a thumb drive on multiple computers and maintain their preferences without
using the system registry. The pref.xml file will usually be stored at the location jGnash was started
from.

--portableFile filename

If you don’t like the location the pref.xml file is stored, or wish to use a different name, use this
option to change the location and name to suit.

--uninstall

Removes all registry and configuration settings jGnash has created. This will not have any effect if
you have been using the -portable option.

Client/Server Options
--server filename

Starts the jGnash server using the specified file. The file must exist and not be in use by another
program. A user interface will not be displayed. The file must be in the Object Database (jdb)
format.
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--host servername

Specifies the name of the remote server. This starts jGnash and automatically connects to the
specified server. If running on the same computer as the server, localhost may be used as the name
of the server.

--shutdown

Issues a shutdown request to a server. If -host is not specified, then localhost is assumed for the
server name

--encrypt

Enables encrypted client / server communication if supported by the relational database (H2 Only).
Remote file transfers and client communications, etc will be encrypted. This will not encrypt your
database file. A password must be used, otherwise encryption will be disabled. Depending on your
locale and export laws, encryption may not be available and will fail if not supported in your
installed JVM.

--password password

The password that the client must correctly specify to connect to the jGnash database. This is not
required if the database is not protected.

--port port

An empty port for network communications. The specified port and port + 1 may not be used by any
other application at the same time. The default port is 5300.


Open Dialog

It is possible to start the jGnash client and specify the server, and password settings

from the File › Open dialog.

Client/Server Examples
Start the jGnash server using the default port with a password protected database

java -jar jGnash2.jar --server /home/craig/jgnash.jdb --password fh56dy

Start the jGnash client and connect to the local server running a password protected database

java -jar jGnash2.jar --host localhost --password fh56dy

Issue a shutdown request to a remote server that is password protected

java -jar jGnash2.jar --shutdown --host localhost --password fh56dy
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Issue a shutdown request to a local server that is not password protected

java -jar jGnash2.jar --shutdown

47



48



Chapter 11. Frequently Asked Questions
Where do I set my opening account balance?

Create an Equity Account called "Opening Balances" and transfer money from the Equity account to
they new account which will establish an opening balance. The "Opening Balances" account may be
hidden later if you do not want it visible.

What happened to transaction categories?

Most commercial personal finance applications use categories to help track spending and income.
jGnash uses Income and Expense accounts instead of categories for tracking where your money
comes from and where it goes.

Can I use multiple currencies?

Yes! The Tools › Currencies › Add/Remove menu will let you add additional currencies.

After adding new currencies, simple create new accounts that use the new currency. When creating
a transaction between accounts with different currencies, a field for the exchange rate will be
enabled.

How do I add Securities / Stocks to my Investment and Mutual Fund Account?

First, you need to have created your stocks/securities. Tools › Commodities › Create / Modify.

When creating the securities, the scale field must be filled in and the prefix field should be filled in.
The scale will general be the same scale as the currency the securities value is reported in. In most
cases, a scale of 2 will work fine. For the prefix, the currency prefix of the reported value should be
used.

After creating your securities, you can go back and modify the existing account or select the
securities when creating a new account. Use the [ Securities ] button in the dialog to make changes.
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Appendix A: Keyboard Shortcuts
This Appendix contains application keyboard shortcuts that are available to you throughout jGnash

Depending on your operating system and how you have it configured, other shortcuts may be available
that perform the same function.

Table 3. Shortcut Keys

Keys Function

CTRL-F4 Closes the active register window if you have one
open

F1 Displays the Help dialog

Table 4. Editing Keys

Keys Function

CTRL-C Copy

CTRL-X Cut

CTRL-V Paste
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Appendix B: GNU General Public License
version 3
Version 3, 29 June 2007 Copyright © 2007 Free Software Foundation, Inc. http://fsf.org/

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it
is not allowed.

Preamble
The GNU General Public License is a free, copyleft license for software and other kinds of works.

The licenses for most software and other practical works are designed to take away your freedom to
share and change the works. By contrast, the GNU General Public License is intended to guarantee
your freedom to share and change all versions of a program—to make sure it remains free software
for all its users. We, the Free Software Foundation, use the GNU General Public License for most of our
software; it applies also to any other work released this way by its authors. You can apply it to your
programs, too.

When we speak of free software, we are referring to freedom, not price. Our General Public Licenses
are designed to make sure that you have the freedom to distribute copies of free software (and charge
for them if you wish), that you receive source code or can get it if you want it, that you can change the
software or use pieces of it in new free programs, and that you know you can do these things.

To protect your rights, we need to prevent others from denying you these rights or asking you to
surrender the rights. Therefore, you have certain responsibilities if you distribute copies of the
software, or if you modify it: responsibilities to respect the freedom of others.

For example, if you distribute copies of such a program, whether gratis or for a fee, you must pass on
to the recipients the same freedoms that you received. You must make sure that they, too, receive or
can get the source code. And you must show them these terms so they know their rights.

Developers that use the GNU GPL protect your rights with two steps: (1) assert copyright on the
software, and (2) offer you this License giving you legal permission to copy, distribute and/or modify it.

For the developers' and authors' protection, the GPL clearly explains that there is no warranty for this
free software. For both users' and authors' sake, the GPL requires that modified versions be marked as
changed, so that their problems will not be attributed erroneously to authors of previous versions.

Some devices are designed to deny users access to install or run modified versions of the software
inside them, although the manufacturer can do so. This is fundamentally incompatible with the aim of
protecting users' freedom to change the software. The systematic pattern of such abuse occurs in the
area of products for individuals to use, which is precisely where it is most unacceptable. Therefore, we
have designed this version of the GPL to prohibit the practice for those products. If such problems arise
substantially in other domains, we stand ready to extend this provision to those domains in future
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versions of the GPL, as needed to protect the freedom of users.

Finally, every program is threatened constantly by software patents. States should not allow patents to
restrict development and use of software on general-purpose computers, but in those that do, we wish
to avoid the special danger that patents applied to a free program could make it effectively proprietary.
To prevent this, the GPL assures that patents cannot be used to render the program non-free.

The precise terms and conditions for copying, distribution and modification follow.

TERMS AND CONDITIONS

0. Definitions.
''This License'' refers to version 3 of the GNU General Public License.

''Copyright'' also means copyright-like laws that apply to other kinds of works, such as semiconductor
masks.

''The Program'' refers to any copyrightable work licensed under this License. Each licensee is
addressed as ''you''. ''Licensees'' and ''recipients'' may be individuals or organizations.

To ''modify'' a work means to copy from or adapt all or part of the work in a fashion requiring
copyright permission, other than the making of an exact copy. The resulting work is called a ''modified
version'' of the earlier work or a work ''based on'' the earlier work.

A ''covered work'' means either the unmodified Program or a work based on the Program.

To ''propagate'' a work means to do anything with it that, without permission, would make you directly
or secondarily liable for infringement under applicable copyright law, except executing it on a
computer or modifying a private copy. Propagation includes copying, distribution (with or without
modification), making available to the public, and in some countries other activities as well.

To ''convey'' a work means any kind of propagation that enables other parties to make or receive
copies. Mere interaction with a user through a computer network, with no transfer of a copy, is not
conveying.

An interactive user interface displays ''Appropriate Legal Notices'' to the extent that it includes a
convenient and prominently visible feature that (1) displays an appropriate copyright notice, and (2)
tells the user that there is no warranty for the work (except to the extent that warranties are provided),
that licensees may convey the work under this License, and how to view a copy of this License. If the
interface presents a list of user commands or options, such as a menu, a prominent item in the list
meets this criterion.

1. Source Code.
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The ''source code'' for a work means the preferred form of the work for making modifications to it.
''Object code'' means any non-source form of a work.

A ''Standard Interface'' means an interface that either is an official standard defined by a recognized
standards body, or, in the case of interfaces specified for a particular programming language, one that
is widely used among developers working in that language.

The ''System Libraries'' of an executable work include anything, other than the work as a whole, that
(a) is included in the normal form of packaging a Major Component, but which is not part of that Major
Component, and (b) serves only to enable use of the work with that Major Component, or to implement
a Standard Interface for which an implementation is available to the public in source code form. A
''Major Component'', in this context, means a major essential component (kernel, window system, and
so on) of the specific operating system (if any) on which the executable work runs, or a compiler used
to produce the work, or an object code interpreter used to run it.

The ''Corresponding Source'' for a work in object code form means all the source code needed to
generate, install, and (for an executable work) run the object code and to modify the work, including
scripts to control those activities. However, it does not include the work’s System Libraries, or general-
purpose tools or generally available free programs which are used unmodified in performing those
activities but which are not part of the work. For example, Corresponding Source includes interface
definition files associated with source files for the work, and the source code for shared libraries and
dynamically linked subprograms that the work is specifically designed to require, such as by intimate
data communication or control flow between those subprograms and other parts of the work.

The Corresponding Source need not include anything that users can regenerate automatically from
other parts of the Corresponding Source.

The Corresponding Source for a work in source code form is that same work.

2. Basic Permissions.
All rights granted under this License are granted for the term of copyright on the Program, and are
irrevocable provided the stated conditions are met. This License explicitly affirms your unlimited
permission to run the unmodified Program. The output from running a covered work is covered by
this License only if the output, given its content, constitutes a covered work. This License
acknowledges your rights of fair use or other equivalent, as provided by copyright law.

You may make, run and propagate covered works that you do not convey, without conditions so long as
your license otherwise remains in force. You may convey covered works to others for the sole purpose
of having them make modifications exclusively for you, or provide you with facilities for running those
works, provided that you comply with the terms of this License in conveying all material for which you
do not control copyright. Those thus making or running the covered works for you must do so
exclusively on your behalf, under your direction and control, on terms that prohibit them from making
any copies of your copyrighted material outside their relationship with you.

Conveying under any other circumstances is permitted solely under the conditions stated below.
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Sublicensing is not allowed; section 10 makes it unnecessary.

3. Protecting Users' Legal Rights From Anti-
Circumvention Law.
No covered work shall be deemed part of an effective technological measure under any applicable law
fulfilling obligations under article 11 of the WIPO copyright treaty adopted on 20 December 1996, or
similar laws prohibiting or restricting circumvention of such measures.

When you convey a covered work, you waive any legal power to forbid circumvention of technological
measures to the extent such circumvention is effected by exercising rights under this License with
respect to the covered work, and you disclaim any intention to limit operation or modification of the
work as a means of enforcing, against the work’s users, your or third parties' legal rights to forbid
circumvention of technological measures.

4. Conveying Verbatim Copies.
You may convey verbatim copies of the Program’s source code as you receive it, in any medium,
provided that you conspicuously and appropriately publish on each copy an appropriate copyright
notice; keep intact all notices stating that this License and any non-permissive terms added in accord
with section 7 apply to the code; keep intact all notices of the absence of any warranty; and give all
recipients a copy of this License along with the Program.

You may charge any price or no price for each copy that you convey, and you may offer support or
warranty protection for a fee.

5. Conveying Modified Source Versions.
You may convey a work based on the Program, or the modifications to produce it from the Program, in
the form of source code under the terms of section 4, provided that you also meet all of these
conditions:

a. The work must carry prominent notices stating that you modified it, and giving a relevant date.

b. The work must carry prominent notices stating that it is released under this License and any
conditions added under section 7. This requirement modifies the requirement in section 4 to ""keep
intact all notices"".

c. You must license the entire work, as a whole, under this License to anyone who comes into
possession of a copy. This License will therefore apply, along with any applicable section 7
additional terms, to the whole of the work, and all its parts, regardless of how they are packaged.
This License gives no permission to license the work in any other way, but it does not invalidate
such permission if you have separately received it.

d. If the work has interactive user interfaces, each must display Appropriate Legal Notices; however,
if the Program has interactive interfaces that do not display Appropriate Legal Notices, your work
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need not make them do so.

A compilation of a covered work with other separate and independent works, which are not by their
nature extensions of the covered work, and which are not combined with it such as to form a larger
program, in or on a volume of a storage or distribution medium, is called an ''aggregate'' if the
compilation and its resulting copyright are not used to limit the access or legal rights of the
compilation’s users beyond what the individual works permit. Inclusion of a covered work in an
aggregate does not cause this License to apply to the other parts of the aggregate.

6. Conveying Non-Source Forms.
You may convey a covered work in object code form under the terms of sections 4 and 5, provided that
you also convey the machine-readable Corresponding Source under the terms of this License, in one of
these ways:

a. Convey the object code in, or embodied in, a physical product (including a physical distribution
medium), accompanied by the Corresponding Source fixed on a durable physical medium
customarily used for software interchange.

b. Convey the object code in, or embodied in, a physical product (including a physical distribution
medium), accompanied by a written offer, valid for at least three years and valid for as long as you
offer spare parts or customer support for that product model, to give anyone who possesses the
object code either (1) a copy of the Corresponding Source for all the software in the product that is
covered by this License, on a durable physical medium customarily used for software interchange,
for a price no more than your reasonable cost of physically performing this conveying of source, or
(2) access to copy the Corresponding Source from a network server at no charge.

c. Convey individual copies of the object code with a copy of the written offer to provide the
Corresponding Source. This alternative is allowed only occasionally and noncommercially, and
only if you received the object code with such an offer, in accord with subsection 6b.

d. Convey the object code by offering access from a designated place (gratis or for a charge), and offer
equivalent access to the Corresponding Source in the same way through the same place at no
further charge. You need not require recipients to copy the Corresponding Source along with the
object code. If the place to copy the object code is a network server, the Corresponding Source may
be on a different server (operated by you or a third party) that supports equivalent copying
facilities, provided you maintain clear directions next to the object code saying where to find the
Corresponding Source. Regardless of what server hosts the Corresponding Source, you remain
obligated to ensure that it is available for as long as needed to satisfy these requirements.

e. Convey the object code using peer-to-peer transmission, provided you inform other peers where
the object code and Corresponding Source of the work are being offered to the general public at no
charge under subsection 6d.

A separable portion of the object code, whose source code is excluded from the Corresponding Source
as a System Library, need not be included in conveying the object code work.

A ''User Product'' is either (1) a ''consumer product'', which means any tangible personal property
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which is normally used for personal, family, or household purposes, or (2) anything designed or sold
for incorporation into a dwelling. In determining whether a product is a consumer product, doubtful
cases shall be resolved in favor of coverage. For a particular product received by a particular user,
''normally used'' refers to a typical or common use of that class of product, regardless of the status of
the particular user or of the way in which the particular user actually uses, or expects or is expected to
use, the product. A product is a consumer product regardless of whether the product has substantial
commercial, industrial or non-consumer uses, unless such uses represent the only significant mode of
use of the product.

''Installation Information'' for a User Product means any methods, procedures, authorization keys, or
other information required to install and execute modified versions of a covered work in that User
Product from a modified version of its Corresponding Source. The information must suffice to ensure
that the continued functioning of the modified object code is in no case prevented or interfered with
solely because modification has been made.

If you convey an object code work under this section in, or with, or specifically for use in, a User
Product, and the conveying occurs as part of a transaction in which the right of possession and use of
the User Product is transferred to the recipient in perpetuity or for a fixed term (regardless of how the
transaction is characterized), the Corresponding Source conveyed under this section must be
accompanied by the Installation Information. But this requirement does not apply if neither you nor
any third party retains the ability to install modified object code on the User Product (for example, the
work has been installed in ROM).

The requirement to provide Installation Information does not include a requirement to continue to
provide support service, warranty, or updates for a work that has been modified or installed by the
recipient, or for the User Product in which it has been modified or installed. Access to a network may
be denied when the modification itself materially and adversely affects the operation of the network
or violates the rules and protocols for communication across the network.

Corresponding Source conveyed, and Installation Information provided, in accord with this section
must be in a format that is publicly documented (and with an implementation available to the public
in source code form), and must require no special password or key for unpacking, reading or copying.

7. Additional Terms.
''Additional permissions'' are terms that supplement the terms of this License by making exceptions
from one or more of its conditions. Additional permissions that are applicable to the entire Program
shall be treated as though they were included in this License, to the extent that they are valid under
applicable law. If additional permissions apply only to part of the Program, that part may be used
separately under those permissions, but the entire Program remains governed by this License without
regard to the additional permissions.

When you convey a copy of a covered work, you may at your option remove any additional
permissions from that copy, or from any part of it.(Additional permissions may be written to require
their own removal in certain cases when you modify the work.) You may place additional permissions
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on material, added by you to a covered work, for which you have or can give appropriate copyright
permission.

Notwithstanding any other provision of this License, for material you add to a covered work, you may
(if authorized by the copyright holders of that material) supplement the terms of this License with
terms:

a. Disclaiming warranty or limiting liability differently from the terms of sections 15 and 16 of this
License; or

b. Requiring preservation of specified reasonable legal notices or author attributions in that material
or in the Appropriate Legal Notices displayed by works containing it; or

c. Prohibiting misrepresentation of the origin of that material, or requiring that modified versions of
such material be marked in reasonable ways as different from the original version; or

d. Limiting the use for publicity purposes of names of licensors or authors of the material; or

e. Declining to grant rights under trademark law for use of some trade names, trademarks, or service
marks; or

f. Requiring indemnification of licensors and authors of that material by anyone who conveys the
material (or modified versions of it) with contractual assumptions of liability to the recipient, for
any liability that these contractual assumptions directly impose on those licensors and authors.

All other non-permissive additional terms are considered ""further restrictions"" within the meaning
of section 10. If the Program as you received it, or any part of it, contains a notice stating that it is
governed by this License along with a term that is a further restriction, you may remove that term. If a
license document contains a further restriction but permits relicensing or conveying under this
License, you may add to a covered work material governed by the terms of that license document,
provided that the further restriction does not survive such relicensing or conveying.

If you add terms to a covered work in accord with this section, you must place, in the relevant source
files, a statement of the additional terms that apply to those files, or a notice indicating where to find
the applicable terms.

Additional terms, permissive or non-permissive, may be stated in the form of a separately written
license, or stated as exceptions; the above requirements apply either way.

8. Termination.
You may not propagate or modify a covered work except as expressly provided under this License. Any
attempt otherwise to propagate or modify it is void, and will automatically terminate your rights under
this License (including any patent licenses granted under the third paragraph of section 11).

However, if you cease all violation of this License, then your license from a particular copyright holder
is reinstated (a) provisionally, unless and until the copyright holder explicitly and finally terminates
your license, and (b) permanently, if the copyright holder fails to notify you of the violation by some
reasonable means prior to 60 days after the cessation.

59



Moreover, your license from a particular copyright holder is reinstated permanently if the copyright
holder notifies you of the violation by some reasonable means, this is the first time you have received
notice of violation of this License (for any work) from that copyright holder, and you cure the violation
prior to 30 days after your receipt of the notice.

Termination of your rights under this section does not terminate the licenses of parties who have
received copies or rights from you under this License. If your rights have been terminated and not
permanently reinstated, you do not qualify to receive new licenses for the same material under section
10.

9. Acceptance Not Required for Having Copies.
You are not required to accept this License in order to receive or run a copy of the Program. Ancillary
propagation of a covered work occurring solely as a consequence of using peer-to-peer transmission to
receive a copy likewise does not require acceptance. However, nothing other than this License grants
you permission to propagate or modify any covered work. These actions infringe copyright if you do
not accept this License. Therefore, by modifying or propagating a covered work, you indicate your
acceptance of this License to do so.

10. Automatic Licensing of Downstream Recipients.
Each time you convey a covered work, the recipient automatically receives a license from the original
licensors, to run, modify and propagate that work, subject to this License. You are not responsible for
enforcing compliance by third parties with this License.

An ""entity transaction"" is a transaction transferring control of an organization, or substantially all
assets of one, or subdividing an organization, or merging organizations. If propagation of a covered
work results from an entity transaction, each party to that transaction who receives a copy of the work
also receives whatever licenses to the work the party’s predecessor in interest had or could give under
the previous paragraph, plus a right to possession of the Corresponding Source of the work from the
predecessor in interest, if the predecessor has it or can get it with reasonable efforts.

You may not impose any further restrictions on the exercise of the rights granted or affirmed under
this License. For example, you may not impose a license fee, royalty, or other charge for exercise of
rights granted under this License, and you may not initiate litigation (including a cross-claim or
counterclaim in a lawsuit) alleging that any patent claim is infringed by making, using, selling, offering
for sale, or importing the Program or any portion of it.

11. Patents.
A ''contributor'' is a copyright holder who authorizes use under this License of the Program or a work
on which the Program is based. The work thus licensed is called the contributor’s ''contributor
version''.
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A contributor’s ''essential patent claims'' are all patent claims owned or controlled by the contributor,
whether already acquired or hereafter acquired, that would be infringed by some manner, permitted
by this License, of making, using, or selling its contributor version, but do not include claims that
would be infringed only as a consequence of further modification of the contributor version. For
purposes of this definition, ''control'' includes the right to grant patent sublicenses in a manner
consistent with the requirements of this License.

Each contributor grants you a non-exclusive, worldwide, royalty-free patent license under the
contributor’s essential patent claims, to make, use, sell, offer for sale, import and otherwise run,
modify and propagate the contents of its contributor version.

In the following three paragraphs, a ''patent license'' is any express agreement or commitment,
however denominated, not to enforce a patent (such as an express permission to practice a patent or
covenant not to sue for patent infringement). To ''grant'' such a patent license to a party means to make
such an agreement or commitment not to enforce a patent against the party.

If you convey a covered work, knowingly relying on a patent license, and the Corresponding Source of
the work is not available for anyone to copy, free of charge and under the terms of this License,
through a publicly available network server or other readily accessible means, then you must either
(1) cause the Corresponding Source to be so available, or (2) arrange to deprive yourself of the benefit
of the patent license for this particular work, or (3) arrange, in a manner consistent with the
requirements of this License, to extend the patent license to downstream recipients. ''Knowingly
relying'' means you have actual knowledge that, but for the patent license, your conveying the covered
work in a country, or your recipient’s use of the covered work in a country, would infringe one or more
identifiable patents in that country that you have reason to believe are valid.

If, pursuant to or in connection with a single transaction or arrangement, you convey, or propagate by
procuring conveyance of, a covered work, and grant a patent license to some of the parties receiving
the covered work authorizing them to use, propagate, modify or convey a specific copy of the covered
work, then the patent license you grant is automatically extended to all recipients of the covered work
and works based on it.

A patent license is ''discriminatory'' if it does not include within the scope of its coverage, prohibits the
exercise of, or is conditioned on the non-exercise of one or more of the rights that are specifically
granted under this License. You may not convey a covered work if you are a party to an arrangement
with a third party that is in the business of distributing software, under which you make payment to
the third party based on the extent of your activity of conveying the work, and under which the third
party grants, to any of the parties who would receive the covered work from you, a discriminatory
patent license (a) in connection with copies of the covered work conveyed by you (or copies made from
those copies), or (b) primarily for and in connection with specific products or compilations that contain
the covered work, unless you entered into that arrangement, or that patent license was granted, prior
to 28 March 2007.

Nothing in this License shall be construed as excluding or limiting any implied license or other
defenses to infringement that may otherwise be available to you under applicable patent law.
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12. No Surrender of Others' Freedom.
If conditions are imposed on you (whether by court order, agreement or otherwise) that contradict the
conditions of this License, they do not excuse you from the conditions of this License. If you cannot
convey a covered work so as to satisfy simultaneously your obligations under this License and any
other pertinent obligations, then as a consequence you may not convey it at all. For example, if you
agree to terms that obligate you to collect a royalty for further conveying from those to whom you
convey the Program, the only way you could satisfy both those terms and this License would be to
refrain entirely from conveying the Program.

13. Use with the GNU Affero General Public License.
Notwithstanding any other provision of this License, you have permission to link or combine any
covered work with a work licensed under version 3 of the GNU Affero General Public License into a
single combined work, and to convey the resulting work. The terms of this License will continue to
apply to the part which is the covered work, but the special requirements of the GNU Affero General
Public License, section 13, concerning interaction through a network will apply to the combination as
such.

14. Revised Versions of this License.
The Free Software Foundation may publish revised and/or new versions of the GNU General Public
License from time to time. Such new versions will be similar in spirit to the present version, but may
differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Program specifies that a certain
numbered version of the GNU General Public License ''or any later version'' applies to it, you have the
option of following the terms and conditions either of that numbered version or of any later version
published by the Free Software Foundation. If the Program does not specify a version number of the
GNU General Public License, you may choose any version ever published by the Free Software
Foundation.

If the Program specifies that a proxy can decide which future versions of the GNU General Public
License can be used, that proxy’s public statement of acceptance of a version permanently authorizes
you to choose that version for the Program.

Later license versions may give you additional or different permissions. However, no additional
obligations are imposed on any author or copyright holder as a result of your choosing to follow a later
version.

15. Disclaimer of Warranty.
THERE IS NO WARRANTY FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW.
EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES
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PROVIDE THE PROGRAM ''AS IS'' WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND
PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE PROGRAM PROVE DEFECTIVE, YOU
ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

16. Limitation of Liability.
IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY
COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MODIFIES AND/OR CONVEYS THE PROGRAM AS
PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, SPECIAL,
INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE
PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED
INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF THE PROGRAM TO
OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

17. Interpretation of Sections 15 and 16.
If the disclaimer of warranty and limitation of liability provided above cannot be given local legal
effect according to their terms, reviewing courts shall apply local law that most closely approximates
an absolute waiver of all civil liability in connection with the Program, unless a warranty or
assumption of liability accompanies a copy of the Program in return for a fee.

END OF TERMS AND CONDITIONS

How to Apply These Terms to Your New Programs
If you develop a new program, and you want it to be of the greatest possible use to the public, the best
way to achieve this is to make it free software which everyone can redistribute and change under
these terms.

To do so, attach the following notices to the program. It is safest to attach them to the start of each
source file to most effectively state the exclusion of warranty; and each file should have at least the
''copyright'' line and a pointer to where the full notice is found.
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one line to give the programs name and a brief idea of what it does.
Copyright (C) year name of author

This program is free software: you can redistribute it and/or modify
it under the terms of the GNU General Public License as published by
the Free Software Foundation, either version 3 of the License, or
(at your option) any later version.

This program is distributed in the hope that it will be useful,
but WITHOUT ANY WARRANTY; without even the implied warranty of
MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE.  See the
GNU General Public License for more details.

You should have received a copy of the GNU General Public License
along with this program.  If not, see http://www.gnu.org/licenses/.

Also add information on how to contact you by electronic and paper mail.

If the program does terminal interaction, make it output a short notice like this when it starts in an
interactive mode:

program Copyright (C) year name of author
This program comes with ABSOLUTELY NO WARRANTY; for details type show w.
This is free software, and you are welcome to redistribute it
under certain conditions; type show c for details.

The hypothetical commands 'show w' and 'show c' should show the appropriate parts of the General
Public License. Of course, your program’s commands might be different; for a GUI interface, you would
use an ''about box''.

You should also get your employer (if you work as a programmer) or school, if any, to sign a ''copyright
disclaimer'' for the program, if necessary. For more information on this, and how to apply and follow
the GNU GPL, see http://www.gnu.org/licenses/.

The GNU General Public License does not permit incorporating your program into proprietary
programs. If your program is a subroutine library, you may consider it more useful to permit linking
proprietary applications with the library. If this is what you want to do, use the GNU Lesser General
Public License instead of this License. But first, please read http://www.gnu.org/philosophy/why-not-
lgpl.html.
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Appendix C: GNU Free Documentation License
Version 1.3, 3 November 2008

Copyright © 2000, 2001, 2002, 2007, 2008 Free Software Foundation, Inc. http://www.fsf.org/

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it
is not allowed.

0. PREAMBLE
The purpose of this License is to make a manual, textbook, or other functional and useful document
“free” in the sense of freedom: to assure everyone the effective freedom to copy and redistribute it,
with or without modifying it, either commercially or noncommercially. Secondarily, this License
preserves for the author and publisher a way to get credit for their work, while not being considered
responsible for modifications made by others.

This License is a kind of “copyleft”, which means that derivative works of the document must
themselves be free in the same sense. It complements the GNU General Public License, which is a
copyleft license designed for free software.

We have designed this License in order to use it for manuals for free software, because free software
needs free documentation: a free program should come with manuals providing the same freedoms
that the software does. But this License is not limited to software manuals; it can be used for any
textual work, regardless of subject matter or whether it is published as a printed book. We recommend
this License principally for works whose purpose is instruction or reference.

1. APPLICABILITY AND DEFINITIONS
This License applies to any manual or other work, in any medium, that contains a notice placed by the
copyright holder saying it can be distributed under the terms of this License. Such a notice grants a
world-wide, royalty-free license, unlimited in duration, to use that work under the conditions stated
herein. The “Document”, below, refers to any such manual or work. Any member of the public is a
licensee, and is addressed as “you”. You accept the license if you copy, modify or distribute the work in
a way requiring permission under copyright law.

A “Modified Version” of the Document means any work containing the Document or a portion of it,
either copied verbatim, or with modifications and/or translated into another language.

A “Secondary Section” is a named appendix or a front-matter section of the Document that deals
exclusively with the relationship of the publishers or authors of the Document to the Document’s
overall subject (or to related matters) and contains nothing that could fall directly within that overall
subject. (Thus, if the Document is in part a textbook of mathematics, a Secondary Section may not
explain any mathematics.) The relationship could be a matter of historical connection with the subject
or with related matters, or of legal, commercial, philosophical, ethical or political position regarding
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them.

The “Invariant Sections” are certain Secondary Sections whose titles are designated, as being those of
Invariant Sections, in the notice that says that the Document is released under this License. If a section
does not fit the above definition of Secondary then it is not allowed to be designated as Invariant. The
Document may contain zero Invariant Sections. If the Document does not identify any Invariant
Sections then there are none.

The “Cover Texts” are certain short passages of text that are listed, as Front-Cover Texts or Back-Cover
Texts, in the notice that says that the Document is released under this License. A Front-Cover Text may
be at most 5 words, and a Back-Cover Text may be at most 25 words.

A “Transparent” copy of the Document means a machine-readable copy, represented in a format whose
specification is available to the general public, that is suitable for revising the document
straightforwardly with generic text editors or (for images composed of pixels) generic paint programs
or (for drawings) some widely available drawing editor, and that is suitable for input to text formatters
or for automatic translation to a variety of formats suitable for input to text formatters. A copy made in
an otherwise Transparent file format whose markup, or absence of markup, has been arranged to
thwart or discourage subsequent modification by readers is not Transparent. An image format is not
Transparent if used for any substantial amount of text. A copy that is not “Transparent” is called
“Opaque”.

Examples of suitable formats for Transparent copies include plain ASCII without markup, Texinfo
input format, LaTeX input format, SGML or XML using a publicly available DTD, and standard-
conforming simple HTML, PostScript or PDF designed for human modification. Examples of
transparent image formats include PNG, XCF and JPG. Opaque formats include proprietary formats
that can be read and edited only by proprietary word processors, SGML or XML for which the DTD
and/or processing tools are not generally available, and the machine-generated HTML, PostScript or
PDF produced by some word processors for output purposes only.

The “Title Page” means, for a printed book, the title page itself, plus such following pages as are needed
to hold, legibly, the material this License requires to appear in the title page. For works in formats
which do not have any title page as such, “Title Page” means the text near the most prominent
appearance of the work’s title, preceding the beginning of the body of the text.

The “publisher” means any person or entity that distributes copies of the Document to the public.

A section “Entitled XYZ” means a named subunit of the Document whose title either is precisely XYZ or
contains XYZ in parentheses following text that translates XYZ in another language. (Here XYZ stands
for a specific section name mentioned below, such as “Acknowledgements”, “Dedications”,
“Endorsements”, or “History”.) To “Preserve the Title” of such a section when you modify the
Document means that it remains a section “Entitled XYZ” according to this definition.

The Document may include Warranty Disclaimers next to the notice which states that this License
applies to the Document. These Warranty Disclaimers are considered to be included by reference in
this License, but only as regards disclaiming warranties: any other implication that these Warranty
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Disclaimers may have is void and has no effect on the meaning of this License.

2. VERBATIM COPYING
You may copy and distribute the Document in any medium, either commercially or noncommercially,
provided that this License, the copyright notices, and the license notice saying this License applies to
the Document are reproduced in all copies, and that you add no other conditions whatsoever to those
of this License. You may not use technical measures to obstruct or control the reading or further
copying of the copies you make or distribute. However, you may accept compensation in exchange for
copies. If you distribute a large enough number of copies you must also follow the conditions in section
3.

You may also lend copies, under the same conditions stated above, and you may publicly display
copies.

3. COPYING IN QUANTITY
If you publish printed copies (or copies in media that commonly have printed covers) of the Document,
numbering more than 100, and the Document’s license notice requires Cover Texts, you must enclose
the copies in covers that carry, clearly and legibly, all these Cover Texts: Front-Cover Texts on the front
cover, and Back-Cover Texts on the back cover. Both covers must also clearly and legibly identify you
as the publisher of these copies. The front cover must present the full title with all words of the title
equally prominent and visible. You may add other material on the covers in addition. Copying with
changes limited to the covers, as long as they preserve the title of the Document and satisfy these
conditions, can be treated as verbatim copying in other respects.

If the required texts for either cover are too voluminous to fit legibly, you should put the first ones
listed (as many as fit reasonably) on the actual cover, and continue the rest onto adjacent pages.

If you publish or distribute Opaque copies of the Document numbering more than 100, you must either
include a machine-readable Transparent copy along with each Opaque copy, or state in or with each
Opaque copy a computer-network location from which the general network-using public has access to
download using public-standard network protocols a complete Transparent copy of the Document, free
of added material. If you use the latter option, you must take reasonably prudent steps, when you
begin distribution of Opaque copies in quantity, to ensure that this Transparent copy will remain thus
accessible at the stated location until at least one year after the last time you distribute an Opaque copy
(directly or through your agents or retailers) of that edition to the public.

It is requested, but not required, that you contact the authors of the Document well before
redistributing any large number of copies, to give them a chance to provide you with an updated
version of the Document.

4. MODIFICATIONS
You may copy and distribute a Modified Version of the Document under the conditions of sections 2

67



and 3 above, provided that you release the Modified Version under precisely this License, with the
Modified Version filling the role of the Document, thus licensing distribution and modification of the
Modified Version to whoever possesses a copy of it. In addition, you must do these things in the
Modified Version:

A. Use in the Title Page (and on the covers, if any) a title distinct from that of the Document, and from
those of previous versions (which should, if there were any, be listed in the History section of the
Document). You may use the same title as a previous version if the original publisher of that
version gives permission.

B. List on the Title Page, as authors, one or more persons or entities responsible for authorship of the
modifications in the Modified Version, together with at least five of the principal authors of the
Document (all of its principal authors, if it has fewer than five), unless they release you from this
requirement.

C. State on the Title page the name of the publisher of the Modified Version, as the publisher.

D. Preserve all the copyright notices of the Document.

E. Add an appropriate copyright notice for your modifications adjacent to the other copyright notices.

F. Include, immediately after the copyright notices, a license notice giving the public permission to
use the Modified Version under the terms of this License, in the form shown in the Addendum
below.

G. Preserve in that license notice the full lists of Invariant Sections and required Cover Texts given in
the Document’s license notice.

H. Include an unaltered copy of this License.

I. Preserve the section Entitled “History”, Preserve its Title, and add to it an item stating at least the
title, year, new authors, and publisher of the Modified Version as given on the Title Page. If there is
no section Entitled “History” in the Document, create one stating the title, year, authors, and
publisher of the Document as given on its Title Page, then add an item describing the Modified
Version as stated in the previous sentence.

J. Preserve the network location, if any, given in the Document for public access to a Transparent
copy of the Document, and likewise the network locations given in the Document for previous
versions it was based on. These may be placed in the “History” section. You may omit a network
location for a work that was published at least four years before the Document itself, or if the
original publisher of the version it refers to gives permission.

K. For any section Entitled “Acknowledgements” or “Dedications”, Preserve the Title of the section,
and preserve in the section all the substance and tone of each of the contributor
acknowledgements and/or dedications given therein.

L. Preserve all the Invariant Sections of the Document, unaltered in their text and in their titles.
Section numbers or the equivalent are not considered part of the section titles.

M. Delete any section Entitled “Endorsements”. Such a section may not be included in the Modified
Version.

N. Do not retitle any existing section to be Entitled “Endorsements” or to conflict in title with any
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Invariant Section.

O. Preserve any Warranty Disclaimers.

If the Modified Version includes new front-matter sections or appendices that qualify as Secondary
Sections and contain no material copied from the Document, you may at your option designate some
or all of these sections as invariant. To do this, add their titles to the list of Invariant Sections in the
Modified Version’s license notice. These titles must be distinct from any other section titles.

You may add a section Entitled “Endorsements”, provided it contains nothing but endorsements of
your Modified Version by various parties — for example, statements of peer review or that the text has
been approved by an organization as the authoritative definition of a standard.

You may add a passage of up to five words as a Front-Cover Text, and a passage of up to 25 words as a
Back-Cover Text, to the end of the list of Cover Texts in the Modified Version. Only one passage of
Front-Cover Text and one of Back-Cover Text may be added by (or through arrangements made by) any
one entity. If the Document already includes a cover text for the same cover, previously added by you
or by arrangement made by the same entity you are acting on behalf of, you may not add another; but
you may replace the old one, on explicit permission from the previous publisher that added the old
one.

The author(s) and publisher(s) of the Document do not by this License give permission to use their
names for publicity for or to assert or imply endorsement of any Modified Version.

5. COMBINING DOCUMENTS
You may combine the Document with other documents released under this License, under the terms
defined in section 4 above for modified versions, provided that you include in the combination all of
the Invariant Sections of all of the original documents, unmodified, and list them all as Invariant
Sections of your combined work in its license notice, and that you preserve all their Warranty
Disclaimers.

The combined work need only contain one copy of this License, and multiple identical Invariant
Sections may be replaced with a single copy. If there are multiple Invariant Sections with the same
name but different contents, make the title of each such section unique by adding at the end of it, in
parentheses, the name of the original author or publisher of that section if known, or else a unique
number. Make the same adjustment to the section titles in the list of Invariant Sections in the license
notice of the combined work.

In the combination, you must combine any sections Entitled “History” in the various original
documents, forming one section Entitled “History”; likewise combine any sections Entitled
“Acknowledgements”, and any sections Entitled “Dedications”. You must delete all sections Entitled
“Endorsements”.

6. COLLECTIONS OF DOCUMENTS
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You may make a collection consisting of the Document and other documents released under this
License, and replace the individual copies of this License in the various documents with a single copy
that is included in the collection, provided that you follow the rules of this License for verbatim
copying of each of the documents in all other respects.

You may extract a single document from such a collection, and distribute it individually under this
License, provided you insert a copy of this License into the extracted document, and follow this License
in all other respects regarding verbatim copying of that document.

7. AGGREGATION WITH INDEPENDENT WORKS
A compilation of the Document or its derivatives with other separate and independent documents or
works, in or on a volume of a storage or distribution medium, is called an “aggregate” if the copyright
resulting from the compilation is not used to limit the legal rights of the compilation’s users beyond
what the individual works permit. When the Document is included in an aggregate, this License does
not apply to the other works in the aggregate which are not themselves derivative works of the
Document.

If the Cover Text requirement of section 3 is applicable to these copies of the Document, then if the
Document is less than one half of the entire aggregate, the Document’s Cover Texts may be placed on
covers that bracket the Document within the aggregate, or the electronic equivalent of covers if the
Document is in electronic form. Otherwise they must appear on printed covers that bracket the whole
aggregate.

8. TRANSLATION
Translation is considered a kind of modification, so you may distribute translations of the Document
under the terms of section 4. Replacing Invariant Sections with translations requires special
permission from their copyright holders, but you may include translations of some or all Invariant
Sections in addition to the original versions of these Invariant Sections. You may include a translation
of this License, and all the license notices in the Document, and any Warranty Disclaimers, provided
that you also include the original English version of this License and the original versions of those
notices and disclaimers. In case of a disagreement between the translation and the original version of
this License or a notice or disclaimer, the original version will prevail.

If a section in the Document is Entitled “Acknowledgements”, “Dedications”, or “History”, the
requirement (section 4) to Preserve its Title (section 1) will typically require changing the actual title.

9. TERMINATION
You may not copy, modify, sublicense, or distribute the Document except as expressly provided under
this License. Any attempt otherwise to copy, modify, sublicense, or distribute it is void, and will
automatically terminate your rights under this License.

However, if you cease all violation of this License, then your license from a particular copyright holder
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is reinstated (a) provisionally, unless and until the copyright holder explicitly and finally terminates
your license, and (b) permanently, if the copyright holder fails to notify you of the violation by some
reasonable means prior to 60 days after the cessation.

Moreover, your license from a particular copyright holder is reinstated permanently if the copyright
holder notifies you of the violation by some reasonable means, this is the first time you have received
notice of violation of this License (for any work) from that copyright holder, and you cure the violation
prior to 30 days after your receipt of the notice.

Termination of your rights under this section does not terminate the licenses of parties who have
received copies or rights from you under this License. If your rights have been terminated and not
permanently reinstated, receipt of a copy of some or all of the same material does not give you any
rights to use it.

10. FUTURE REVISIONS OF THIS LICENSE
The Free Software Foundation may publish new, revised versions of the GNU Free Documentation
License from time to time. Such new versions will be similar in spirit to the present version, but may
differ in detail to address new problems or concerns. See Copyleft [http://www.gnu.org/copyleft/].

Each version of the License is given a distinguishing version number. If the Document specifies that a
particular numbered version of this License “or any later version” applies to it, you have the option of
following the terms and conditions either of that specified version or of any later version that has been
published (not as a draft) by the Free Software Foundation. If the Document does not specify a version
number of this License, you may choose any version ever published (not as a draft) by the Free
Software Foundation. If the Document specifies that a proxy can decide which future versions of this
License can be used, that proxy’s public statement of acceptance of a version permanently authorizes
you to choose that version for the Document.

11. RELICENSING
“Massive Multiauthor Collaboration Site” (or “MMC Site”) means any World Wide Web server that
publishes copyrightable works and also provides prominent facilities for anybody to edit those works.
A public wiki that anybody can edit is an example of such a server. A “Massive Multiauthor
Collaboration” (or “MMC”) contained in the site means any set of copyrightable works thus published
on the MMC site.

“CC-BY-SA” means the Creative Commons Attribution-Share Alike 3.0 license published by Creative
Commons Corporation, a not-for-profit corporation with a principal place of business in San Francisco,
California, as well as future copyleft versions of that license published by that same organization.

“Incorporate” means to publish or republish a Document, in whole or in part, as part of another
Document.

An MMC is “eligible for relicensing” if it is licensed under this License, and if all works that were first
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published under this License somewhere other than this MMC, and subsequently incorporated in
whole or in part into the MMC, (1) had no cover texts or invariant sections, and (2) were thus
incorporated prior to November 1, 2008.

The operator of an MMC Site may republish an MMC contained in the site under CC-BY-SA on the same
site at any time before August 1, 2009, provided the MMC is eligible for relicensing.

ADDENDUM: How to use this License for your
documents
To use this License in a document you have written, include a copy of the License in the document and
put the following copyright and license notices just after the title page:

Copyright © YEAR YOUR NAME

Permission is granted to copy, distribute and/or modify this document under the
terms of the GNU Free Documentation License, Version 1.3 or any later version
published by the Free Software Foundation; with no Invariant Sections, no
Front-Cover Texts, and no Back-Cover Texts. A copy of the license is included in
the section entitled “GNU Free Documentation License”.

If you have Invariant Sections, Front-Cover Texts and Back-Cover Texts, replace the “with… Texts.” line
with this:

with the Invariant Sections being LIST THEIR TITLES, with the Front-Cover Texts
being LIST, and with the Back-Cover Texts being LIST.

If you have Invariant Sections without Cover Texts, or some other combination of the three, merge
those two alternatives to suit the situation.

If your document contains nontrivial examples of program code, we recommend releasing these
examples in parallel under your choice of free software license, such as the GNU General Public
License, to permit their use in free software.
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